Tideda definitions - Tutorial


Like any piece of technology, time-series databases and Tideda have a number of terms that are used to describe the features of data.  These terms are reasonably common across the industry, and this is how they are defined and used within Tideda in particular.



Item – piece of data, e.g. water level

Element – Item(s) + their associated times

Batch – a sequence of Elements that represent a continuous record, or a rating curve

Gap – interval between Batches

File – many batches (often including many Sites)

Archive – many Files

Data types:
There are several types (kinds) of time-series data according to how they are interpolated (or not interpolated) between their recorded intervals. 
The purpose of having these different kinds is to allow data values to be stored without doing any arithmetic on the numbers. In fact, the same information can be represented using the other kinds, and the only reason for providing a range of kinds is to reduce the decisions made when data are captured. The arithmetic to convert to other kinds, if needed, is delayed until an application requires it.
[bookmark: _Toc467162456]Instantaneous
 Instantaneous data are the most common and originate from recorders that take readings at regular intervals of time; e.g., water level readings.
[bookmark: _Toc467162457]Incremental
Incremental data have each value measuring an accumulation over a period of time. Normally, counts of events (e.g., rainfall bucket tips) are recorded at set intervals. Zero values (e.g., no rain) will not generate any values. 
[bookmark: _Toc467162458]Histogram
Histogram data have constant values over each period of time; e.g. spillway gate openings, and the data are interpolated so that they plot as a histogram. In some cases, the data may be derived from averages being computed and stored. 
[bookmark: _Toc467162460]Discrete
Discrete data are values that cannot normally be interpolated because they are known or expected to be discontinuous. Examples are spot values of water quality parameters and flow measurements such as gaugings. 

Site - a recording station, whether water-level, rainfall or other parameter.  If there is more than one parameter measured at a location, they are normally given different site numbers (necessary if the data are of different types, e.g., water-level and rainfall).  For several parameters to have the same site number, a multi-item file will need to be used.  and the recording interval will need to be the same.
Multi-item file - a Tideda file with several parameters recorded with the same recording interval at usually at the same location (e.g., a multi-parameter water quality sensor set).
[bookmark: _GoBack]It is strongly recommended you read chapter 14 of the TIDEDA manual = Organisation of Data
Tideda file creation:

File – Create new File
	
The following notes illustrate by example how to create a new Tideda file.  This is necessary if you want to keep certain sites in separate files; or keep raw data separate from archived data; or pass only some data onto other users.

Creating a new Tideda file using File – Create New File:

Two aspects are of importance, 

a) Not to create an ‘Old Version file’

b) To decide if this new file is going to be an Extended Directory or a Normal Tideda file.  We will just cover a Normal Tideda file.  

Steps:

Open Tideda 
Select File / Create New File
[image: ]

The following window should pop up:
[image: ]

Here you have to change the location and name of the Tideda file, by clicking on ‘Browse…’.
Here you have to deselect ‘Extended Directory’ if it has been selected.
Here you can change the value for ‘Number of Batches’.  1536 is a good number, but in some cases, one might have to increase this value.  

DO NOT SELECT ‘Create Old Version file’

Press OK and a new file will be created that is ready to use.










Tideda - Getting started


Getting Started:

Start by double clicking on the Tideda for Windows icon.  A window titled 'NIWA Tideda (Version 4)' will appear.  This window can be moved and re-sized in the usual ways.

[image: ]

	It is a good idea to 'maximise' the window to give the maximum area for plotting.  This is done by clicking on the button at the top right of the window.

	Open a Tideda data file by selecting the File Open option from the menu bar at the top of the window.   This displays the MS Windows File Open dialogue box which allows you to select a file from any drive or directory in the usual way.

[image: ]

	Select your file by clicking on it then clicking the ‘Open’ button.

[image: ]
The tool bar gives single click access to options which are also available in the pull down menus.  From left to right they are:

	Open a new window
	Open a new data file
	Cut, Copy, Paste		
	Print
	Print preview				
	View options
	Graph options
	New page, Same page, Over plot
	Graph
	Text
	Version information

You can use this when you are more familiar with the program.   In particular, you will find the New page, Same page and Over plot buttons more convenient than selecting the plot type from the Graph menu.


Selecting the data to use or view:

After selecting the input file, the Site, Item and Time range to be used can be specified before selecting a Tideda process. However, it is generally more convenient to choose the data using the Data button within the individual process dialogue boxes.

	Click on the Data menu item to bring up the Data dialogue box. Chose “Select Data”.

[image: ]

	The Site can be selected from either the 'Site Number' or the 'Site Title' box.   If there is no attribute file connected then the site titles will be 'untitled', in that case you would have to use the site number box to select the site.

[image: ]

	The 'Measurement' box is a combination of the Item and Rate options. For single item data with ratings the choice is stage or flow (from the attribute record for this site).   For 15 item gauging data the list includes all 15 items from the gauging.   If there is no attribute file then the items are referred to by the item number.  The presentation units option is selected from here.

	Click on the 'Measurement'  box and select an item.

	The Time Range can be set by editing the values in the 'From' and 'To' boxes, or by clicking on the 'From' and 'To' short cut buttons at the bottom of the data box to select the full time range for this site.

	Click on the 'OK' button to accept the data selection.

Hint:	Double clicking on the date or time boxes allows the new value to be typed in Tideda format (yymmdd or hhmmss).

Hint:	The Date Format option is set by the View Options menu item or by clicking on the View Options icon from the tool bar (the icon that looks like an eye).


Graphing data

The Graph menu contains the Tideda Plotting processes and options.  These processes are:

[image: ]

Plot the hydrograph of the selected data:

	Click on the Graph menu to bring up the plot processes and options.

	Make sure the New Page option [image: ] is checked, then select Graph over Time from the Graph menu.  This brings up the Plgraph options dialogue box.

	Click on the Options... button in this box to bring up the general Graph Options box.

[image: ]

	In the 'Graph Position' area, check the Use all the Window option to fit the plots to the window size.  Check the graph options required in the area at the bottom of this dialogue box - for example, Vertical axis numbering and Site title.

[image: ]

	The graph colours are selected in the Colours area of the graphics options box.   You can set your own combination or leave them as they are.

	Click the 'OK' button to accept the options and return to the Plgraph options box.

	Set the Mul, Div and Add options are set to 1, 1 and 0 respectively, if not already set.

	Set Max and Min (and retrieval interval if dealing with incremental data like rainfall).

	Click the 'OK' button to display the plot.

[image: ]

Add an 'Over plot' to the same axes:

	Select the Data menu option again and from “Select Data” choose a second site, leaving the time range as it was.

	Click on 'OK' to accept this.

	Notice that the Status Bar now shows the new site selection.

























	From the Graph menu, select the Plot Type/Over plot option, or use the overplot icon, then select 'Graph over Time' again.

	Click on the 'Graph Options...' button in the Plgraph box to bring up the 'Graph Options' box.

	Select a different colour for the Data then click on 'OK' to return to the 'Plgraph options' box.

	Click on 'OK' to add the Over-plot.

[image: ]

Add another plot to the 'Same Page':

	From the Data menu, select a third site, leaving the time range as it was.

	Click on 'OK' to accept this.

	From the Graph menu, select the 'Same Page' option or use the [image: ] icon.

	Re-size the plot window by 'pulling' down the bottom of the window to leave a blank area below the existing plot axes to put the same page plot into.

	From the Graph menu, select 'Graph over Time'.

	Set the retrieval interval and the Max and Min then click on 'OK' to add the plot below the hydrograph.


Open a New File in a New Window:

	Use the File Open menu item and select a second file.
	A new window is opened with the file name in the title.  You can move and re-size this window at any time.

	From the Data menu, select your site and date range.

	Select a process e.g. Table – Quick Extremes.

	Select the options you want and click on OK.

Now click on the original window, note the “data bar” changes as the active window changes.
This has demonstrated the basic process of analysing data in multiple windows and from different files.

Other combinations are possible, such as plotting sites from different files in the same window using the Change item in the File menu.

Data copying and moving tutorial

Move / Copy


The following notes illustrate by example how to copy data from one file to another.  


Copying data using Move / Copy / All Kinds:

Select Move / Copy / All Kinds, which should bring up the following pop-up menu:
[image: ]


And the following window should pop up:
[image: ]
As you can see, here you have several options:
· You can select the ‘Destination File’, the location and the name
· You can determine which Tideda site number the destination data should have, by writing a number into the field next to the ‘Destination Site Number’
· You can select the data you want to copy by pressing on ‘Data…’ 
· The ‘Gap tolerance’ is used in the case that the destination file already has some data in it, and if new and old data have a gap of more than given in the ‘Gap tolerance’ box, then a Gap will be filed.



Copying rating data using Move / Copy / Ratings:

When selecting Move / Copy / Rating, you should get the following pop-up window:
[image: ]

As you can see, the ‘Copy Ratings’ is selected.  Now you have to make several selections:
· Select the Tideda site number for which you want to copy the ratings by pressing ‘Data…’
· You also have to specify which rating to copy, by choosing a number between 1 and 15 in the field next to ‘Rating Item’  (1 is normally for conversion from stage to flow, 2 might be from stage to sediment concentration,..)
· You also can select the ‘Destination Item’, again a number between 1 and 15. (Normally use 1).


Copying data using Move / Copy / Series Data:

When selecting Move / Copy / Series Data, you should get the following pop-up window:
[image: ]
The resulting data in the destination file will ONLY be the instantaneous series data.



Copying the entire series, ratings, and gaugings using Move / Include:

To copy all the data for an entire site from one file to the other, it is best to use the Include options.

Steps:
Open the destination file
Open the file from where the data shall be taken
Select: Move / Include
[image: ]
And the following window should pop-up:

[image: ]

Here you will have to select the site by pressing ‘Data…’ and selecting the Tideda site number.
In addition, you have to press ‘Browse…’ to the location and name of the destination file.
As can be seen, no change in Tideda site numbering can be undertaken.

When pressing on the ‘Data..’ button, the following window will pop-up:
[image: ]
As you can see, only a single site can be selected, either based on ‘Site Number’ or based on ‘Site Title’.



Finding a Site number

To find the Site number you want, you can get some assistance, if needed, by clicking on the ‘Site Filter…’ as follows:

[image: ]

By selecting ‘Site Number Begins’ and writing, for example, ‘22’ into the adjacent field, and then pressing ‘OK’, in the ‘Site Select’ window, for the drop down menu of the ‘Site Number’ only sites starting with ‘22’ will be displayed:

[image: ]


Other Menus in Tideda:

The following section describes the functions available within other menus 

File menu

[image: ]

Not all the options are described here. Please refer to the Tideda manual for a complete set of explanations.

Open  		Opens a file in a new window.

		[image: ] from the toolbar may be used instead.

Change 		Changes the file that is open in the current window.

Create  	Creates a new Tideda file.  This is the same as the Create File option in the Manage menu.

Close  		Closes the current window.

Attribute 	Opens an attribute file for the current window. By default an attribute file is opened with the same name as the data file. Using this option you can change from the default attribute file. 

Run  		Run a script file. 

Preferences	Set general Tideda options such as the default attribute file, printers, working directory and source of comments.

Print  		Print to the windows printer. This can be changed from the Print option, the Preferences dialog, or from windows print manager.

		[image: ] from the toolbar may be used instead.

Print Preview  	Allows you to preview what your printed page is going to look like.

		[image: ] from the toolbar may be used instead.

Recent files 	The most recent files you opened are listed. The exact number can be set using the Preferences option. Any of them can be opened by double clicking anywhere on their name.

Exit  		Exit from Tideda.



Edit menu

[image: ]

Not all the options are described here. Please refer to the Tideda manual for a complete set of explanations

Copy  		This copies your selection to the Clipboard. If your current window contains a plot, the entire plot is copied, and you do not need to select it. If your window is text, first select the area you want to copy by clicking and holding down the left mouse button. Move the mouse to the end of the area to be selected and release the mouse button, then click on Copy. 
	The [image: ] icon from the toolbar may be used instead.

Copy All	Copies all text in the text window.

Edit 	“commands” allow the editing of site attributes, a list (text) file, or comments associated with the data for selected site.



View menu

[image: ]


Toolbar  		If this is checked then the toolbar is displayed. The toolbar is the set of icons or buttons below the menu headings. 

Data bar  		If this is checked the data bar is displayed. The data bar displays information on the current window i.e. site number, site name, quantity and time range selected. This information changes when another window becomes the current window.

Status bar  		If this is checked the status bar is displayed at the bottom of the Tideda base window. This bar contains information on the current state of Tideda and on the options the user may be selecting.

Text and Graph  Either text or graph may be checked. If text is checked, then the current window displays text. If Graph is checked then graphical output is displayed output, so in one window you can toggle between two sets of information.

		[image: ] from the toolbar selects graph

	[image: ] from the toolbar selects text

Options  		Data presentation options such as the date/ time format can be selected.

	[image: ] from the toolbar may be used instead.


Data Menu

[image: ]

Scan		Scans the input file and gives a summary of the data contents

Select Data	The following entry panel is displayed for the user to select the data they want for the current window.

[image: ]

Not all the options are described here. Please refer to the Tideda manual for a complete set of explanations

The site may be selected by clicking on the [image: ] symbol in the displayed Site Number box [image: ], by entering the site number from the keyboard, or selecting by the site name in the Site Title box [image: ] (assuming the correct attribute file has been selected). 

The data type is then selected by clicking on the [image: ] symbol in the Measurement box.
[image: ]
The time range entered by typing it into the From and To boxes. The two long buttons at the bottom of the box display the start and finish dates of the data for the site selected. You can set either your From or To date by clicking on them. The dates are displayed in Tideda or calendar format, which ever is specified in the View options.

The presentation units/ file units option are selected in this dialogue box.


Graph menu

[image: ]

Not all the options are described here. Please refer to the Tideda manual for a complete set of explanations

Graph over Time  	Plot series data against time.

Ratings  	Plot rating curves.

Distribution 	Plots distributions of the data.

Scatter plot  	Plots one item against another.

Graph and Zoom  	Plots data and then allows you to zoom the plot.

Special  	Clicking on this option opens a new set of option as shown below. Please refer to the Tideda manual for a complete set of explanations
[image: ]

Bed plot  	Plots deviation of gaugings from  rating curves.

Log of time  	Plots time as a log scale.

Graph and Edit  	Plots data, allows you to zoom and graphically perform a number of data editing processes.

Plot Type   	Allows the user to select the type of plot required. New Page means that the plot is done on a new page. [image: ] from the toolbar may be used instead. Same page means the plot is on the same page. Refer to the “getting started” section on how to use this option effectively. [image: ] from the toolbar may be used instead. Over plot means the plot is over plotted on the existing plot axes.[image: ] from the toolbar may be used instead.

Options  	Allows access the plotting options

[image: ]

Use all the Window 	This option automatically selects all the plot options to make the plot fill the entire window. When this option is selected you have no control over Top margin size etc.

Colours  	Are selected from the listed colours. 

Print setup  	This is the standard windows print setup dialogue.

Page setup  	Do this before printing. These options position your plot on the page of paper. The origin is the top left of your paper. (Hint - Start your word processor and check what margins you use, and make these options the same. That way when you copy and paste a plot into a document it will fit in correctly).[image: ] from the toolbar may be used instead.
 

Table menu

[image: ]

Quick Extremes  	Display maximum and minimum values for the data.

List  	Print raw data to screen or file.

Export	Writes data to a file in a variety of formats suitable for importing into other programs e.g. Excel.


Statistics	Allows access to these options: 
[image: ]
	where:
	Summary gives summary statistics for the selected data.
Distribution  displays cumulative frequency distribution of series data.
Moving  finds the maximum or minimum values in a time series using a moving average.
Quick Extremes  	displays maximum and minimum values for the data.

Calendar	Allows access to these types of tables options:
[image: ]
where:
Hourly  Display hourly means on a monthly basis.
Daily  Display daily means on annual basis.
Weekly  (Pweek)	Display daily, weekly, monthly, seasonal and annual values.
Monthly  Display monthly means in calendar form.

Options  	Select various options that apply to tabular output.
	
	[image: ] from the toolbar may be used instead

Move menu

[image: ]


Transform  	Apply transformations to the specified data.

Compress  	Applies Tideda Compression to series data.

Select  	Copies data from one site to another filtered by a data range.

Maxima  	Writes the maximum value in each calendar month to the output site.

Merge	Combine series data into a multi-item destination file. Merge1 creates a new site, Merge 2 writes to the existing  site.

Melem  	Combines data on an element by element  basis.

Psim  	Run a Psim simulation program.

Moving Means	Writes a file of moving means calculated from the data

Copy  	Copy data from one Tideda site or file to  another.

Include  	Copy all data from a specified site.

Update	Copies newer data from the input file to the destination (output) file

Combine  	Copy a complete Tideda file into another.

Attributes	Used for handling Attribute data.

Please see the Tideda manual for a fuller description of these options.

Manage menu

[image: ]


Scan  	Show what sites are in the current data file.

Graph Pscan	Show the contents of the current file in graphical form

Gap  	Display and optionally remove gaps.

Dgap	Removes gaps of less than a specified duration

Delete  	Delete selected data for a site. 

Delete Site	Deletes all data for the current site

Batch  	Delete or copy data batches.

Create	Create an empty Tideda file.
 
Release  	Copy all current data to a new Tideda file. This is a management tool used to reclaim space in a Tideda file by removing data that has been superseded by more recently edited data covering the same period.

Entry menu

[image: ]


List to Tideda  	Import data from the list file to a Tideda file.

Tapes	Enables processing of a range of paper tape types from older style dataloggers.

Circular Charts	Enables processing of a range of circular chart types.

Strip Charts	Enables processing of a range of strip and rectangular chart types.

Keyboard entry  	Allow manual entry of data from the keyboard.

Extras

[image: ]

Event Analysis		Enables a range of extreme value type analyses

Rating Editor	Enables flow gauging information to be used to automatically create water level-to-flow rating curves.

Rating Quality	A suite of tools for checking rating curves and gauging data.


Comments

[image: ]

Edit	Allows existing comments to be edited and new ones to be added. Creates a new comment file if one does not already exist.

Table	Tabulates comments.

Export	Exports comments to another file

Import	Allows comments to be imported from a suitably formatted file.


Window menu

[image: ]

New window 	Open a new window of the currently active window i.e. if the current window is i:\tideda\huru.mtd with attribute file i:\tideda\sites.att, then clicking on new will open a second window with these files opened. [image: ] from the toolbar may be used instead.

Cascade  	Arrange the opened windows in an overlapping (cascaded) format.

Tile  	Arrange the opened windows in a tiled format.

Arrange icons  	Arrange any iconised windows along the bottom of the base Tideda window.

Following that is a list of the currently open windows. By clicking on any of these sets that window to be the current window. 


Hints

Using Copy and Paste:  Set up your page margins to be the same as those of the program you are pasting into. Graphs are copied as Windows Meta Files (WMF), not bitmaps, so they can be re-sized in Excel (for example). When in Excel you can double click on a pasted plot to start Microsoft Draw to alter the plot (no need to use Plannotate or Plotter ever again). If a pasted plot looks “odd”, re-size it slightly and this will fix the problem. Word (for example) sometimes has trouble displaying WMFs correctly.
	Highlight text you are interested in then use Copy to get Pday etc. output into Excel quickly. You can omit the superfluous headings and only Copy the data you are interested in. Then use Paste and Data -> Text to Columns in Excel to format the data.

Excel:	Process Export allows quick transfer of data into Excel files. Check the Copy to Clipboard check-box, then use Paste in Excel to paste in the data.
 
Printing:  	Do set up your margins. You can print to an encapsulated postscript file using   Print Options.

Script files:	To print from a script file insert a plf /p command after the plotting command i.e. you will also get screen output, a plf /p is just like pressing the printer icon on the toolbar.
	
You can display on-line documentation using the ‘Help’ menu. The ‘Readme.txt’ file contains brief details of recent enhancements and fixes. The Release Notes contain more detailed documentation of enhancements since the Reference Manual was printed. The Reference Manual is the published Tideda Manual in a PDF format.
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